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1 Introduction

The HP Operations Smart Plug-in for Oracle Application Server (Oracle AS SPI) allows you to
manage Oracle Application servers from an HP Operations Manager for Windows (HPOM)
console. Oracle AS SPI adds monitoring capabilities otherwise unavailable to HPOM. For
more information on HPOM, see the HPOM console online help.

From the HPOM console, you can monitor the availability, use, and performance of Oracle
Application Servers running on HPOM managed nodes. You can integrate Oracle AS SPI with
other HPOM products like HP Reporter and HP Performance Manager to get consolidated
reports and graphs which help you analyze trends in server usage, availability, and
performance.

The Oracle AS SPI online help provides valuable information about Oracle AS SPI concepts
and other topics that will help you understand the product.

This guide covers the following topics:

¢ Installing and Removing the Oracle AS SPI

¢ Configuring the Oracle AS SPI

e (Customizing Oracle AS SPI Policies

¢ Integrating HPOM Reporting and Graphing Features with the Oracle AS SPI
¢ Troubleshooting the Oracle AS SPI
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2 Installing and Removing the Oracle AS SPI

Installing the Oracle AS SPI

You must install the prerequisite software on your system before installing the Oracle AS SPI.
A complete list of software requirements is given in the Smart Plug-in for Oracle Application
Server Release Notes.

If HPOM is already installed, it is not necessary to stop the existing HPOM sessions before
installing the Oracle AS SPI. To install the Oracle AS SPI on the management server, follow
these steps:

1 Insert the HP Operations Smart Plug-ins DVD into the DVD drive of the management
server system. The HP Operations Smart Plug-in InstallShield Wizard starts.

2  Click Next. The Program Maintenance window opens.
3 Select Install Products. The Product Selection window opens.

4 From the options listed (there are three Product Selection windows) select the OracleAS
SPI check box and click Next.

Complete the installation by following the instructions that appear as you proceed. For more
information see the HP Operations Smart Plug-ins DVD Installation and Upgrade Guide.



Upgrading the Oracle AS SPI

Detailed information about supported software, enhancements, fixes, and known problems
and workarounds is available in the HP Operations Smart Plug-in for Oracle Application
Server Release Notes, HP Operations Smart Plug-ins DVD, in
\Documentation\Releasenotes\Oracle AppServer Releasenotes.html.

Prerequisites

1

Make a backup of the existing Oracle AS SPI configuration file which is located at:
\<OvOWSharelnstallDir>\SPI-Share\wasspiloas\conf\SiteConfig

On OVO for Windows 7.50, <OvOWSharelnstallDir> can be C: \Program Files\HP
OpenView\Data\shared\

Install the new version of the Oracle AS SPI by running the InstallShield Wizard
(installer).

If the installer detects that an older version of the Oracle AS SPI is installed, it upgrades
to the new version by doing the following:

e Renames the existing SPI for OracleAS policy group to SPI for OracleAS - Saved
Policies. The default policies you customized in the SPI for OracleAS policy group are
available in the SPI for OracleAS - Saved Policies policy group.

e Updates the Oracle AS SPI instrumentation on the management server.

e Installs new tools, policies, and a graph file on the management server.

Upgrading the Oracle AS SPI

To upgrade the Oracle AS SPI to version 5.10, follow these steps:

1

Install the Oracle AS SPI version 5.10 software, See Installing the Oracle AS SPI on
page 9.

Deploy new instrumentation to the SPI for OracleAS node group:
a Right-click the SPI for OracleAS node group.

b  Select All Tasks > Deploy instrumentation.

¢ Select SPI for OracleAS and OASSPI Discovery.

d Verify that the “Remove existing instrumentation before deploying new
instrumentation” checkbox is clear.

e Click OK.

’ After upgrading the Oracle AS SPI if you add an instance of Oracle Application Server on a
managed node, you must run the Discover OracleAS tool on that node.
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Removing the Oracle AS SPI

To completely remove Oracle AS SPI, you must delete all Oracle AS SPI program components
and policies. Then, complete the following tasks in the order given.

Task 1: Remove all Oracle AS SPI Policies from the Managed Nodes

If you have customized policies (copies of Oracle AS SPI default policies) you must first
remove them before starting this task. After removing the customized policies, follow these
steps:

1 From the HPOM console tree, select Policy management = Policy groups.

2 Right-click SPI for Oracle Application Server and select All Tasks = Uninstall from... A node
selection window opens.

Select the nodes on which the policies are installed. Click OK.

4  Click Deployment jobs under Policy management to verify if all policies are removed. There
must be no policies listed under Deployment jobs.

Make sure you have removed all Oracle AS SPI policies before you start the next task.

Task 2: Remove Oracle AS SPI Node Groups on the Management Server

If you created the SPI for Oracle Application Server node groups by (by running the Create
OASSPI Node Groups tool or manually), you must remove this node group.

1 In the HPOM console tree, select Nodes — SPI for Oracle Application Server.
2 Open the Node Configuration editor.
a Select the Nodes folder in the console tree.
b  Click the node icon & in the Configuration toolbar to open the editor. A node list
appears.

3 Right-click the node group you want to delete and select Delete. You can also select the
node group and press the Delete key. The Confirm Delete window opens.

4  Click Yes.

5 Click OK to close Configure managed nodes window.

Task 3: Remove the Oracle AS SPI Software from the Management Server

1 Insert the HP Operations Smart Plug-ins DVD into the DVD drive of the management
server. The HP Operations Manager InstallShield Wizard opens.

Click Next. The Program Maintenance window opens.
Click Remove products. The Product Selection window opens.

Select the Oracle Application Server check box and click Next.

O A W N

To complete the removal, follow the instructions that appear as you proceed.
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3 Configuring the Oracle AS SPI

This chapter explains how to configure the Oracle AS SPI for use with HP Operations
Manager for Windows (HPOM). You must first complete the configuration prerequisites and
the basic configuration, and then complete additional configuration based on your
environment.

Configuration Prerequisites

Complete the following tasks before configuring the Oracle AS SPI.

Task 1: Add Managed Nodes

For each Oracle Application Server you want to manage from HPOM, ensure that all nodes on
which the Oracle Application Servers are running are configured in HPOM as managed
nodes.

To add a UNIX managed node, follow these steps:

1 Install the HP Operations agent on the node. For more information, see the topic Agent
Installation on UNIX computers in the HPOM console online help.

2  Specify each Oracle Application Server node on UNIX to be managed. For more
information, see the section Configuring managed nodes in the HPOM console online
help.

To add a Windows managed node specify each Oracle Application Server node on Windows to
be managed. The HP Operations agent is automatically installed when you complete this step.

For more information see the section Configuring managed nodes in the HPOM console online
help.

Task 2: Verify the Application Server Status

You can verify if your Oracle Application Servers are running by checking the status of the
server in the Oracle Application Server administrative console. You can see this console on the
web browser by typing:

http://<machinename>:<port no>/emd/console
For example, http://vmwasspiw9.india.hp.com:1156/emd/console
The Oracle AS SPI discovery policies only discover application servers that are running.

As the following figure shows, in the console, colored arrows (in the status column) show the
status of the server.

e Green arrow (pointing upwards): server is running.
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Red arrow (pointing downwards): server is not running. If the arrow is red, start the

server.
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Basic Oracle AS SPI Configuration

To complete the basic Oracle AS SPI configuration, complete the tasks given below in the
specified order.

Configuration Prerequisite

Before launching the Discover OracleAS tool, deploy the following instrumentation files on
the managed nodes:

SHS Data Collector
SPI Data Collector
SPI for OracleAS
OASSPI Discovery

To deploy these instrumentation files, follow these steps:

1

2
3
4

From the HPOM console select Operations Manager = Nodes.
Right-click the managed node on which you want to run Discover OracleAS tool.
Select All Tasks = Deploy instrumentation. The Deploy Instrumentation window opens.

Select SHS Data Collector, SPI Data Collector, SPI for OracleAS, and OASSPI Discovery
from the list of instrumentation files and click OK.

To verify that these files deployed successfully, check Deployment Jobs under Policy
management. There should be no error messages.

Task 1: Launch Discover OracleAS

You must run the Discover OracleAS tool to set the basic configuration properties required for
the Oracle AS SPI to discover instances of the Oracle Application Server, deploy the Oracle AS
SPI discovery policies, and update the service map.

To update the configuration, follow these steps:

1

From the HPOM console select Operations Manager — Tools = SPI for Oracle Application
Server > OASSPI Admin.

Double-click Discover OracleAS. The Edit Parameters window opens.

Select the managed nodes on which Oracle Application Servers are running and click
Launch.

The Console Status window opens. After a few seconds the OASSPI Configure Tool:
Introduction window opens. This window contains a brief information about the Discover
OracleAS tool.

Click Next to start the discovery. The Confirm Operation window opens. Verify the nodes
on which the operation is to be performed.

Click OK.

Configuring the Oracle AS SP/ 15
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Wait for the discover process to complete before going to the next task. The discover
process may take several minutes to complete.

’ If you click Cancel in the Confirm Operations window, the discovery policies are not
deployed. However, the changes you made to the configuration remain in the
management server’s configuration. To make the changes to the selected managed
nodes’ configuration, you must launch the Discover OracleAS tool, select those
managed nodes, click Next in the configuration editor, and then click OK in the
Confirm Operations window.

6 Ifthe discovery is successful, the following message appears in the Discover OracleAS
tools window:

Discovery started on node: <node>
Finished running the Discovery application

Click OK to close the message window.
Click Close to close the Console Status window.

7 If the Discover OracleAS tool does not complete successfully, the following message
appears in the application window:

Failed to run discovery on node <node>

Scan the Console Status window for error messages. If there is an error message in the
Console Status window, see Troubleshooting the Discovery Process on page 51.

Task 2: Verity the Discovery Process

Depending on the number of managed nodes in your environment, verification may take
several minutes to complete.

To verify if the discovery process is successfully completed, follow these steps:
1 Check if the following message appears in the message browser of the managed node:

INFO - Updating the OASSPI configuration data with discovered
information

It may take several minutes for this message to appear for all managed nodes, depending
on the number of managed nodes in your environment.

If the Oracle AS SPI discovery policies are successfully deployed, this message appears
and the letter “S” (for successful) appears in the ‘A’ column of the console.

If this message does not appear or if the message appears but the letter “F” appears in the
‘A’ column, check for error messages. To troubleshoot, see Troubleshooting the Oracle AS
SPI on page 47.

2 From the HPOM console tree select Operations Manager - Services > Applications - Oracle
Application Servers. The service map appears. It may take some time for the service map to
appear completely.

3 Verify that the OC4J and OHS server instances are represented correctly.

After the discovery process is complete, the appropriate Oracle AS SPI group
policies are deployed on the managed nodes. After the policies are deployed, an
automatic procedure to set up a managed node for Oracle AS SPI operations starts.

4 Launch the Verify tool, 10 minutes after the service map appears, to verify if the
installation is complete. To launch the Verify tool, follow these steps:
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a From the HPOM console, select Operations Manager = Tools = SPI for Oracle Application
Server = OASSPI Admin.

b Double-click Verify. Select where to launch this tool window opens.
c¢ Select the nodes on which you want to run the Verify tool.
d Click Launch. The Tool Status window opens.

e In the Launched Tools field the status of the tool must appear as succeeded. In the
Tool Output field the message Installation is clean must appear.

If this message does not appear, see the Tool Output field for error messages.

f  Click Close.

Additional Oracle AS SPI Configuration

After you successfully complete the basic Oracle AS SPI configuration, you must finish Oracle
AS SPI configuration by setting the properties that are not automatically discovered by the
Discovery policies and install and configure additional components. Setting some of these
properties and configuring additional components depends on your environment.

e Ifyou installed HP Reporter (which must be purchased separately), for installation and
configuration information, see Integrating the Oracle AS SPI with HP Reporter on
page 36.

e Ifyou installed HP Performance Manager (which must be purchased separately) and you
want to view graphs, set the GRAPH_URL property. For installation and configuration
information see Integrating the Oracle AS SPI with HP Performance Manager on page 43.

To set additional properties, follow these steps:

1 From the HPOM console, select Operations Manager - Tools — SPI for Oracle Application
Server = OASSPI Admin.

2 Double-click Configure OASSPI. The Edit Parameters window opens.

3 Select the managed nodes to configure.

4 Click Launch. The Console Status window and then the Introduction window opens.
5 Click Next. The configuration editor opens.

6  Set the properties.

7 Click Next to save and exit the configuration editor.

For a complete description of Oracle AS SPI properties and information about setting the
properties using the configuration editor, see the section Configuration properties in the
Oracle AS SPI online help.

Configuring the Oracle AS SP/ 17
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4  Customizing Oracle AS SPI Policies

Oracle AS SPI policies help you monitor the Oracle Application Servers. You can customize
these policies depending on the requirements of your IT environment. This chapter includes
general guidelines about the Oracle AS SPI policies and explains how you can customize
them. For more information see the Policies section in the Oracle AS SPI online help.

Oracle AS SPI Policy Groups and Types

You can customize the Oracle AS SPI policies to suit the needs of your IT environment.
However, these policies can also work without any modification. For more information, see the
Policy Groups section in the Oracle AS SPI online help.

Oracle AS SPI Policy Groups

The Oracle AS SPI policies are organized under the top-level - SPI for Oracle Application
Server policy group (as shown in the following figure.)

@ Services ﬂ Marne

- [igl Modes E onsser
- Tools [58 0ASSPT Discovery

P Certificate requests
El*%? Palicy management
EI Policy groups
#-{& Hierarchical Mode Groups
-{E HPOM Self Management
- {E Microsoft Windows
=[5 samples
{5 self Healing
-- Service Reports Maintenance

SPI For Cracle Application Server
=[50 OASSPI

- - Logfiles

-- Metrics

: -- Monitars

& 0ASSPI Discovery

-] SPI Far Unix 05 JIE] I

The parent policy group—SPI for Oracle Application Server— contains the OASSPI policy
group and the OASSPI Discovery policy group.

The OASSPI policy group includes the following policy groups:
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¢ Logfiles: Policies in this group generate messages according to logfile and error text
detected in both the Oracle Application Server logfiles and in the Oracle AS SPI logfiles.
The Logfiles policy group contains the following policies:

— OracleAS Logs: This policy monitors the OracleAS log files.
— OASSPI-Logfile-Monitor: This policy monitors the OracleAS log files.

Both OASSPI-Logfile-Monitor and OracleAS Logs policies monitor Oracle AS log files.
— OASSPI Error Log: This policy monitors the OASSPI error log.

e Metrics: The policies in this group generate messages according to threshold settings
that monitor Oracle Application Server availability and performance metrics.

¢ Monitors: This group contains collector policies that pertain to all metrics scheduled to
be collected in the specified collection interval. These policies are named according to
collection intervals.

The Discovery policy group includes the following policies:

e OASSPI Messages: This policy intercepts Oracle AS SPI messages for the HPOM
message browser.

e OASSPI Service Discovery: This policy gathers the information used by the
management server to update the service map.

The Discovery policy automatically updates the Oracle Application Server configuration
information in the service map. Clear the AUTO_DISCOVER check box in the configuration
editor if you do not want the discovery policy to automatically overwrite the configuration
defined by you. For more information on the configuration editor see Configuring Oracle AS
SPI section in the Oracle AS SPI online help.

Oracle AS SPI Policy Types

Metric policies define how data is collected for the individual metric and set a threshold value.
When this threshold is exceeded alerts/messages appear in the message browser. You can
change the threshold within a policy by opening the policy (double-click the policy name),
clicking the Threshold levels tab, and then clicking Threshold level in the Level Summary pane.
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Incoming values for metric OASSPI-0220 are compared against its threshold limits. For
example, in the following figure, the default threshold is set at 100.
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Collector policies define all metrics for the Oracle Application Server that are scheduled for
collection at a specified interval. The collector policy names include the collection interval (for
example, OASSPI-OC4J-15min if the collection interval is 15 minutes).

You can open a collector policy (double-click the policy name) and see all the metrics (by
number) collected within an interval. When you double-click the policy, the Measurement
Threshold window opens. All the metrics collected appear in the Command box. The metrics
are preceded by the -m option of the collector/analyzer command wasspi oas ca.

Basic Policy Customizations

This section covers basic policy customizations like changing threshold values, scheduling or
deleting a metric from data collection, opening a metric policy or collector policy and so on.

Before you begin to customize any of the policies, make copies of the original policies so that
the default policies remain intact.

Customizing Oracle AS SPI Policies 2]
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Modifying Metric Policies

You can modify the metric attributes for all monitored instances of Oracle Application Server.
Some of these attributes are defined in the Configuration Properties section in the Oracle AS
SPI online help.

Threshold Level and Actions

To modify the threshold level and actions of a policy, follow these steps:

1 From the HPOM console go to Operations Manager - Policy management - Policy groups —
SPI for Oracle Application Server > OASSPI = Metrics.

2 Double-click the policy for which you want to change the threshold value. The policy
window opens.

3 Select the Threshold Levels tab and double-click the policy description in the window that
opens. The Threshold Level window opens.

The following figure shows the Threshold Level window.

Threshold level "0ASSPI-0232.1: Warning Threshold™ E3 |

General I Start au:tiu:unsl Continue au:tiu:unsi End au:tiu:unsl
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i~ Short-term pealks
I™ lagnare single shartterm peaks ooouring within |0 =4 1 |0 —J |30 = =

= E-I Reszet

{* Reset value iz zame value as threshold limit

{~ Specify a special reset value for the threzhold level

Sources [lezeithan) |

k. I Cancel Help

You can modify the following attributes from the Threshold Level window:

e Threshold limit: If the threshold limit is met or crossed the Oracle AS SPI triggers an
alarm or message.

e Short-term peaks: Short-term peak is a minimum time period over which the monitored
value must exceed or drop (for minimum thresholds) the threshold before a message is
generated. When you set a short-term peak value then a message is sent only if the
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monitored value exceeds the threshold limit each time the value is measured during the
duration of time you select. If the duration is set to 0 or the box is left empty, an alarm is
generated as soon as HPOM detects that the threshold has been equaled or crossed.

® Reset: Reset is the limit below which the monitored value must drop or exceed (for
minimum thresholds) to return the status of the monitored object to normal.

As the following figure shows, the Threshold Level window has the following three action
tabs. You can click any of the action tabs to set the related actions.

Threshold level "0ASSPI-0232.1: Warning Threshold™

General Start actions | Continue actions Endacl.iﬂml

|f the threshold Emit iz met or crozsed, then stait the specified actions [meszage
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Dperstor-nitated command... |
Graph Template - OC4) EJE Calls Process Rate, 04

(] 8 Cancel Help

e  Start actions: Start actions are the actions carried out the first time the threshold is
crossed.

e Continue actions: Continue actions are actions carried out at each subsequent polling
interval if the monitored value did not attain the reset value

e End Actions: End actions are actions carried out after the monitored value crosses the
reset value.

In each of the actions tabs, you can set the type of actions to perform.

The Oracle AS SPI lets you generate graphs and reports, or to add custom programs. You can
generate the reports and graphs through:

® Automatic command: An automatic command runs when the rule is matched. The
automatic command that is delivered with the Oracle AS SPI generates a snapshot report
that shows the data values at the time the action was triggered because of an exceeded
threshold. You can view the report in the message annotations.

Customizing Oracle AS SPI Policies 23
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Operator-initiated command: An operator-initiated command is attached to the message
that the rule sends to the message browser. You can run this command from the message
browser. The operator-initiated command delivered with the Oracle AS SPI lets you click
Perform Action in the Message Properties window to view a graph of the metric whose
exceeded threshold generated the message, along with other related metric values.

Message and Severity

To modify the message and severity of a policy, follow these steps:

1

From the HPOM console select Operations Manager — Policy management — Policy groups
— SPI for Oracle Application Server = OASSPI = Metrics.

Double-click the policy for which you want to modify the severity and message text. The
Measurement Threshold window opens.

Double-click the threshold level description. A new window opens. Click the Start Actions
tab.

Click Message. The Outgoing Message window opens.

Click the Message Attributes tab and make the necessary modifications. Click OK.
In the Outgoing message defaults window you can modify the following attributes:
e Severity: Indicates the importance of the event that triggers this message.

e Message Text: You can modify the text of the message but do not modify any of the
parameters—beginning with $and surrounded by <> brackets—in a message.

Click Save and Close in the policy window to save the changes and exit.

Advanced Policy Customizations

Advanced Policy customizations include making copies of default policy groups to customize a
few settings and deleting whole groups of metrics within a policy’s command line.

Creating New Policy Group

You can keep the custom policies that you create separate from the original default policies by
creating new policy groups. Before you create a new policy group you must first determine the
metrics and policies you want to modify. To create a new policy group, follow these steps:

1

Create a new policy group:
a In the HPOM console select Operations Manager > Policy management - Policy groups.
b  Right-click the policy group you want to copy and select Copy.
For example, right-click the Metrics policy group under OASSPI and select Copy.
¢ Right-click the group under which this policy group is located and select Paste.
For example, right-click OASSPI and select Paste.
d Right-click the new group and select Rename. Type in a new name.

For example, right-click Copy of Metrics and select Rename.
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2 Rename the original policies within the new policy group:

a Double-click the new policy group to get a list of the policies.

b Double-click a policy. The policy window opens.

¢ Click File - Save As. The Save As window opens.

d Type a new policy name and click OK.

e Click File = Exit to close the policy window.

3 Delete all original policies within the new policy group. To do this, select the policies and
press the Delete key. The Confirm multiple delete window opens.

Click Yes to confirm delete; otherwise click No.

4  Alter the renamed policies within the new group as necessary.

Oracle AS SPI Collector/Analyzer Command with Parameters

The wasspi_oas_perl -S wasspi_oas_ca command is used in every collector policy. You can view
the default command line parameters within each collector policy in the Command box in
HPOM console. Double-click the policy to open the policy window, the Command box is a part

of this window.

Basic Collector Command Parameters

The wasspi_oas_ca command is required to start the Oracle AS SPI data collection. You can
add other parameters to this command. The following table lists the parameters used by the

default collector policies.

Table 1

Collector Command Parameters

Parameter

Description

Syntax with Example

—-e

(exclude) Allows you to
exclude specific servers; may
not be used with -i option.

Syntax: -e <server_name>

Example: -e server2, server4

(include) Allows you to list
specific servers to monitor.
This option may not be used
with -e option.

Syntax: -i <server_name>

Example: -i serverl, server3

(metric) Specifies the metric
numbers or number ranges on
which to collect data.

Syntax: -m <metric_number,
metric_number_range>

Example: -m 1,3-5,9-11,15

-matchver

(match version) Specifies the
exact Oracle Application
Server version to monitor.
This option may not be used
with the -minver or -maxver
options. If no matching
versions are found, the
command does not run.

Syntax: -matchver
<version_number>

Example: -matchver 6.1

Customizing Oracle AS SPI Policies
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Table 1 Collector Command Parameters

Parameter Description Syntax with Example

-maxver (maximum version) Specifies | Syntax: -maxver
the highest Oracle <version_number>
Application Server version to | Example: -matchver 7
monitor. Use with -minver to
specify a range of versions. If
no matching versions are
found, the command does not
run.

-minver (minimum version) Specifies | Syntax: -minver
the lowest Oracle Application | <version_number>
Server version to monitor. Example: -matchver 6.1
Use with -maxver to specify a
range of versions. If no
matching versions are found,
the command does not run.

-r (report) Generates an ASCII | Syntax: -r
report for the specified
metrics.

-t Allows you to create a new Syntax: wasspi oas ca
policy group by adding a <prefix>-<collector _policy>
prefix to an existing collector | -m <metric_number> -type
policy along with the metric | <prefix>-
numbers. Example: wasspi oas ca -m

1,2,10,11 -t DEV

-type Allows you to specify the type | Syntax:
of Oracle Application Server | Example: wasspi_oas ca -m
(OC4J or OHS) 1,2,5,10,11,260 —type ajpl3

-x Allows you to specify a property and value.

Syntax: -x <property>=<property_value>

<property> can be one of the following:

® alarm: When off, overrides any default alarming defined for

the metric.
Example: -x alarm=off

e prefix: Default: JMXUDM . Specify the prefix of the metric ID.
Example: -x prefix=SALES

e Print: When on, prints the metric name, instance name, and
metric value to STDOUT in addition to any configured

alarming or logging.
Example: -x print=on

e graph: When off, prevents graphing function.

Example: -x graph=off

e report: When off, prevents reporting function.

Example: -x report=off
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Examples

e To collect specific data on all configured servers:

wasspi oas ca -m 1,2,10,11 -minver 10.0
e To collect data from specific servers only:

wasspi oas ca -m 1,2,10,11 -minver 10.0-i serverl, server2
e To not collect data from specific servers:

wasspi oas ca -m 1,2,10,11 -minver 10.0-e serverl, server2

Changing the Collection Interval for Scheduled Metrics

You can change the collection interval for all scheduled metrics by changing the Polling
Interval in the respective collector policy. For example, to change the collection interval of
default metrics from 5 minutes to 10 minutes for the Oracle AS SPI collector policy
OASSPI-0C4J-05min, follow these steps:

1 From the HPOM console, select Operations Manager - Policy management — Policy groups —
SPI for Oracle Application Server > OASSPI = Monitor.

2 Double-click the collector policy OASSPI-0C4J-05min. The Measurement Threshold window
opens.

Click File > Save As. The Save As window opens.

4 Change the existing name in the Name box to OASSPI-0C4J-10min.
Set the new interval.
a Click the Schedule tab.
b  From the Schedule Task drop-down list select “Once per interval”.
a Set the interval to 10 minutes.

6 Deploy the new policy.
a Right-click OASSPI-0C4J-10min and select All Tasks = Deploy on....
b  Select the nodes on which to deploy the policy.
¢ Click OK.

Changing the Collection Interval for Selected Metrics

You can change the collection interval of metrics, according to the requirements of your
environment. For example, you can change the collection interval from 15 minutes to 10
minutes for metrics C108 and C109.

) The following steps show how to change metrics C108 and C109 of collector policy
OASSPI-OHS-15min, but you can change the collection interval of any metric using these
steps.

To change the collection interval, follow these steps:
1 Rename the selected metrics to reflect the new interval.

a From the HPOM console, select Operations Manager — Policy management = Policy
groups —> SPI for Oracle Application Server = OASSPI = Monitor.
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b Double-click the collector policy OASSPI-OHS-15min. The Measurement Threshold
window opens.

¢ Click File - Save As. The Save As window opens.

d In the Name box change the existing name to OASSPI-OHS-10min. Click OK to
confirm save or click Cancel to discard changes.

In the Command text box, delete all metrics after -m except 108, 109.
Set the new interval.
a Click the Schedule tab.

b  From the Schedule task drop down list, select “Once per interval” and set the interval
to 10 minutes.

¢ Click Save and Close to confirm the changes and close the policy window.

Edit the original policy to remove the modified metrics.

a Double-click the default collector policy OASSPI-OHS-15min. The policy window opens.
b In the Command box, delete metrics 108, 109 after -m.

¢ Click Save and Close to save the changes.

Deploy the modified policies.

a Right-click OASSPI-OHS-10min and select All Tasks = Deploy on....

b  Select the nodes on which you want to deploy the policy.

c¢ Click OK.

d Right-click OASSPI-OHS-15min and repeat steps b-d.

Customizing the Threshold for Different Servers

You can set different threshold values for the same metrics on different servers according to
your needs. For example, you could set the threshold value for metric C220 at 90 for
SERVER_1 but let the threshold be 100 for all other servers. To do this you can copy the
existing condition and modify it to serve as the exception. Follow these steps:

1

o O A WN

Double-click the metric you want to customize (for example, double-click OASPI-0220).
The Measurement Threshold window opens.

Select the Threshold levels tab.

Select the desired condition and click Copy to make a copy of the condition.

Name the condition OASSPI-0220. 2.

Click Specify instance filters... The New Rule window opens.

Select the Condition tab and in the Object Pattern field, enter the following details:
<ServerName.varl>:<ServerPort.var2>:<NodeName.var3>:<*.vard>:<*.var5>:<*var6>

For Example: If you want to set threshold for the application server SERVER _1, enter the
following:

SERVER1 :<* .var2>:<* .var3>:<* .vard>:<* .var5>:<* .var6>

varl, var2, var3, var4, var5, and varé are user defined variables. These variables must be
different from the HPOM policy variables.

Click OK.
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8 Double-click the condition OASSPI-0212.2. The Threshold Level window opens.
9 Change the threshold limit to 90. Click OK.

10 Click Save and Close in the Measurement Threshold window, to save the changes and exit.

Creating Custom Tagged Policies

You can customize a policy by using the tag option (-t on the command line) that allows the
collector/analyzer to recognize customized policies that have a tag attached to the name. This
option gives you with the flexibility of using more than a single set of policies to define
conditions pertaining to specific installations of Oracle Application Server.

When multiple nodes are managed by a number of groups, you can use this option to create
specially tagged policies that are separate from your original setup. In such a case, you must
make copies of the policies, rename them with the tag and rework the collector policy to pick
up the tagged names, then assign the policies to the various groups.

For example, you could create a group of policies and change each policy name to include
CLIENTO1 in it. You could name a metric policy as CLIENT01-OASSPI-0001 (retain the
name of the metric used). The collector policy could be named FIRST_CLIENT-OHS-05min.
You could also set up another group for SECOND_CLIENT and change all those policies to
include CLIENTO02 in the name.

Create a New Tagged Policy Group

To create a new tagged policy group, follow these steps:
1 Copy the original policy group.

a Right-click the policy group you want to copy and select Copy.
For example, right-click the Metrics policy group under OASSPI and select Copy.

b  Right-click the group under which this policy group is located and select Paste.
For example, right-click OASSPI and select Paste.

¢ Right-click Copy of Metrics and select Rename. Rename the new group to identify the
new metric policies.
For example, rename the group to CLIENT01Metrics.

d Select File— Exit to close the policy window.
2 Rename the original policies within the new policy group.

The names of the metric policies in the new group must contain the new name followed by

the original metric number. For example, you can rename a copy of OASSPI-0001 as
CLIENTO01-OASSPI-0001.

The name you give to the new collector policy must also contain the identifying name. You
must modify the scheduled collection to include the new group by inserting the -t
parameter in the Command box. The Command box is in the policy window that appears
when you double-click the collector policy.

For example: wasspi ocas ca -m 1,12,16 -t CLIENTO1-

a Double-click the policy. The policy window opens.
b  Click File = Save As. The Save As window opens.
¢ Type a new policy name and click OK.

3 Select the original policies within the new policy group and press Delete to delete all the
original policies. The Confirm multiple item delete window opens.
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4  Click Yes to confirm delete.

Policy Variables

You can use the following variables when you create your own policies.

Table 2 Policy Variables

Name Description

instancename The instance for which the SPI reports the metric in case of
multi-instance metrics.

Example: /oc4j/Petstore/EJBs/shoppingcartEjb.jar/
TheCart/ejbActivate

node The node on which the OC4J/OHS server is running.
Example: mool.hp.com

servername The OC4J/OHS server name. This corresponds to the NAME
configuration property.

Example: my server

service_key The service ID used to light up the nodes in the service map.

Restoring Default Oracle AS SPI Policies

To restore the default Oracle AS SPI policy groups on your HPOM management server, you
must remove and then reinstall the Oracle AS SPI. See Removing the Oracle AS SPI on
page 11 and Installing the Oracle AS SPI on page 9.

Viewing Text-Based Reports

>»

Some policies have actions defined with threshold violations or error conditions. These actions
automatically generate reports. The reports are snapshots of data values collected from the
server around the time the alarm occurred.

The reports discussed in this section are different from HP Reporter reports that show
consolidated data generated as web pages in a management-ready presentation format. See
Integrating the Oracle AS SPI with HP Reporter on page 36.

Automatic Command Reports

Many metrics generate Automatic Command reports. These reports are generated as soon as
an alarm is triggered in HPOM. Automatic Command reports are generated for a single
Oracle Application Server instance with the exceeded threshold.

When an Automatic Command report is executed from HPOM, the server is queried for
additional data. If you set the HPOM console message browser to display the SUTAON
column, you can see an “S” under the “A” column (see the following figure). This indicates that
a generated report is available in the Annotations area of the Message Properties.
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To view Automatic Command reports, do one of the following:

e Double-click a message in the HPOM message browser. The Message Properties window
opens. Select the Annotations tab.

¢ Right-click a message and select Annotations. The Message Properties window opens.

The reports are available in the Message Properties window. These reports show data values
of a single server. Column descriptions in the window provide further information.

Manually Generated Reports

Reports are generated for all Oracle Application Server instances configured on the managed
node. In contrast to Automatic Command reports that are generated for a single Oracle
Application Server instance, manually generated reports reflect the current state of all Oracle
Application Servers on the managed node.

To manually generate a report, follow these steps:

1 From the HPOM console, select Operations Manager = Tools = SPI for Oracle Application
Server = OASSPI Reports.

2 Double-click the report you want to see. The Select where to launch this tool window
opens.

3 Select the managed node for which you want to see reports and Click Launch. The Tool
Status window opens.

4 View the report in the tool output field.

5 Click Close to close the window.
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Sample Report

The following figure shows the format of a Oracle AS SPI report. This report is automatically
generated (Automatic Command report).

B Tool Status H= E3
pl_0As CA =T = 5 =Mt
Tool Qutput:
£l
Rapore for Applicatisn Server home
Jan 29, Z006 Z:27:57 AN
Hetric COOS_JVHMaenUcilPex
JVH Data Free Heap Memory (HE) Heap Size (KE) Aeorive Threads Up Time (msecs)
L TVH 1,957 4,700 21 166,490,782
(Ho data available for server HITP Server.
-
1| |
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Oracle AS SPI Graphs

Some policies have operator actions associated with them that allow you to generate a graph.
To view these graphs, follow these steps:

1 Double-click a message in the HPOM message browser. The Message Properties window
opens.

2 Click the Commands tab. You can generate a graph if an operator-initiated command is
configured and data is collected.

3 Click Start to generate the graph.
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5 Integrating HPOM Reporting and Graphing
Features with the Oracle AS SPI

Oracle AS SPI can be integrated with the following HP products. These products must be
purchased separately.

HP Reporter

Reporter produces management-ready web page reports that show historical and trends
related information.

After you integrate HP Reporter with Oracle AS SPI, Reporter generates a variety of
reports, every night, that show consolidated information about the performance and
availability of Oracle Application Server instances on configured managed nodes. See
Integrating the Oracle AS SPI with HP Reporter on page 36.

HP Performance Manager
HP Performance Manager provides graphing capability.

You can view the graphs after integrating the Oracle AS SPI with HP Performance
Manager. The graphs are available only if performance data is logged in the default
performance subagent CODA or HP Performance Agent. CODA is automatically deployed
on all HPOM managed nodes.

See Integrating the Oracle AS SPI with HP Performance Manager on page 43.

Figure 1l The Management Server Console Tree
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Integrating the Oracle AS SPI with HP Performance Agent

If your IT environment requires you to generate graphs and reports from historical data or to
store large volumes of performance data, you may want to use the HP Performance Agent 3.x
to collect and store performance data. HP Performance Agent must be purchased separately.

The data collected by HP Performance Agent is used by HP Reporter and HP Performance
Manager.

’ If you are running HP Performance Agent 4.x for Linux, you are not required to configure the
Oracle AS SPI data collector to use HP Performance Agent. By default, the Oracle AS SPI
detects and uses this version of HP Performance Agent to collect and store performance data.

To configure the Oracle AS SPI data collector to use HP Performance Agent, follow these
steps:

1 Create a nocoda.opt file on the managed node, in the following directory:

Operating System File Location

HP-UX, Linux, Solaris /var/opt/OV/conf/dsi2ddf/

AIX /var/lpp/OV/conf/dsi2ddf/

Windows C:\Program Files\HP Openview\data\conf
\dsi2ddf\

If the directory dsi2ddf does not exist, create it.
2 Edit the nocoda. opt file to contain a single line:
ALL
3 Save the file.

Integrating the Oracle AS SPI with HP Reporter

Before integrating the Oracle AS SPI with Reporter, you must configure the Oracle AS SPI by
deploying the software, configuring server connection, and assigning or deploying policies on
target managed nodes.

To integrate the Oracle AS SPI with Reporter, follow these steps:
1 Install the Oracle AS SPI report package on the Windows system running Reporter:

a Insert the HP Operations Smart Plug-ins DVD into the DVD drive of the Windows
system running Reporter. The HP Operations Manager InstallShield Wizard opens.

b Click Next. The Program Maintenance window opens. Click Install Products. The
Product Selection window opens.

¢ From the options listed (there are three Product Selection windows), select the
Reporter option of Oracle AS SPI and click Next.
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d Complete the installation by following the instructions that appear as you proceed.

) On Windows 2000 managed nodes, when installing the Oracle AS SPI report
package, you may get an error message indicating that the installer has detected
an older version of the installer on your system. You can safely ignore the message
and continue.

2 To see the Reporter window, click Start > All Programs - HP OpenView —> Reporter -
Reporter.

3 Check the Reporter window (see the illustration that follows) to note changes made in
Reporter’s configuration.

In the Reporter Status pane (at the bottom of the Reporter window), you can view
information on programs that are running and any errors occurring on the managed
nodes. You can check the status pane to see whether Reporter is updated with the Oracle
AS SPI reports.
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In the Reporter Help, you can find instructions for assigning Oracle AS SPI reports to the
target nodes. To access Help, follow these steps:

a Right-click Reports or Discovered Systems in the left panel of the Reporter main
window.

b  From the submenu, select Report Help or Discovered Systems Help.

¢ Read the topic, To assign a report definition to a Discovered Systems Group.
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4 Add group and single system reports by assigning reports as desired. (For complete
information, see the Reporter Help and the online Concepts Guide.).

Group and single system Oracle AS SPI reports require that you identify systems by their full

name. For example, abc.xyz.com is acceptable while abc is not.

Viewing Reports from the HPOM Management Console

To view Oracle AS Reports from the HPOM Console, follow these steps:

1 Close the HPOM for Windows console (if it is open).

2 Open the HP Reporter window. Click File = Configure - Options. The Configure Reporter

Options window opens.
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fo 7

—

-3 Discover
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Metric Lis | Feature selection
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¥ Generate spstem groups by HPOM NodeGroups
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A 200708123 1
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| MB
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and user details. The user must be an HPOM administrator (a member of the

HP-OVE-Admins group). Click OK.

4 From the menu bar again, click Action > Run = Run All.

| reon N R
Ready . | -
3 In the HPOM for Windows Settings section, specify the name of the management server
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This will discover the node data from HPOM and generate the reports. This may take
some time.

5 After the HP Reporter tasks complete, open the HPOM console. Reports will be visible in
the console tree.

Reports Generated by Reporter

The reports available through the integration of Reporter and the Oracle AS SPI show
consolidated data on performance and availability of Oracle Application Server instances on
the configured managed node (see Sample Report on page 42).

These reports are usually available one day after you install the Oracle AS SPI report package
on the Reporter Windows system. See Integrating the Oracle AS SPI with HP Reporter on
page 36 if you have not completed the report package installation.

After you integrate Oracle AS SPI with HP Reporter, you can see the list of reports under
“Reports” section in the HPOM console.

The following tables show all pre-defined reports for groups (one or more managed nodes on
which an Oracle Application Server instance is installed) and single systems.

Table 3 Reports for All Systems - Oracle Application Server Performance

OracleAS
Title Description Version

EJB Method Calls Process Rate | Shows the number of all EJB method calls | 9.04, 10.1.2,
- Top 20 per minute for the top 20 servers. 10.1.3

The top 20 servers are selected based on the
highest average method calls per minute
over the reporting period.

Servlet Active Threads - Top 20 | Shows the average number of active servlet |9.04,10.1.2,
threads for the top 20 OC4Js. 10.1.3

The top 20 OC4Js for the group are selected
based on the highest average number of
active threads over the reporting period.

Servlet Average Execution Shows the average servlet execution time for | 9.04, 10.1.2,
Time - Top 20 the top 20 OC4dJs. 10.1.3

The top 20 OC4Js for the group are selected
based on the highest average servlet
execution time over the reporting period.
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Table 4 Reports for All Systems - Oracle Application Server Availability

Title

Description

Oracle AS
Version

Server Availability

Contains a daily histogram showing the
percentage of uptime. In addition, a
trendline provides the number of
measurements performed, indicating how
much data was available to determine
availability.

Uptime and downtime are measured by the
Oracle AS SPI. A lower than expected trend
line may indicate systems were unavailable
or the data collection not running.

9.04, 10.1.2,
10.1.3

Table 5 Reports for Single Systems

Title

Description

OracleAS
Version

HTTP Server and OC4J
Availability Details

Contains spectrum graphs showing minutes
of uptime by day and hour for the system.
Uptime and downtime are measured by the
Oracle AS SPI. “No Data” may include
system downtime or data collection not
running. Graphs are based on measured
uptime and downtime only (that is, standby =
down).

The spectrum graphs use color to indicate the
uptime percentage during each hour of each
day.

9.04,10.1.2,
10.1.3

HTTP Server and OC4dJ
System Resource Utilization

Contains spectrum graphs showing CPU and
system memory utilization day and hour for
the system. Uptime and downtime are
measured by the Oracle AS SPI. “No Data”
may include system downtime or data
collection not running. Graphs are based on
measured uptime and downtime only

(that is, standby = down).

The spectrum graphs use color to indicate the
uptime percentage during each hour of each
day.

9.04,10.1.2,
10.1.3

HTTP Server Connections

Shows the average number of HTTP
connections for each application server on the
system

9.04,10.1.2,
10.1.3
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Table 5

Reports for Single Systems

OracleAS
Title Description Version
DB Connection Cache Contains spectrum graphs showing the 9.04,10.1.2,
Utilization percent DB connection cache utilization by 10.1.3
day and hour for a system.
“No Data” may include system downtime or
data collection not running.
0C4J WebContext Sessions Shows the average number of WebContext 9.04,10.1.2,
sessions for each OC4J instance on the 10.1.3
system.
EJB Method Calls Process Shows the number of all EJB method calls 9.04,10.1.2,
Rate - Top 20 per minute for the top 20 servers. The top 20 | 10.1.3
servers for the system are selected based on
the highest average method calls per minute
over the reporting period.
Servlet Average Execution Shows the average servlet execution time for |9.04,10.1.2,
Time - Top 20 the top 20 OC4dJs. The top 20 OC4dJs for the |10.1.3
system are selected based on the highest
average servlet execution time over the
reporting period.
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Sample Report

Avg. Number of Connections

HTTP Server Connecticns

5.00

4.00

3.00

2.00 —
\/‘ A

0.00

0 @02 0 02

Removing the Oracle AS SPI Reporter Package

To remove the Oracle AS SPI Reporter Package, follow these step:

1

Insert the HP Operations Smart Plug-ins DVD into the DVD drive of the Windows system
running Reporter. The HP Operations Manager InstallShield Wizard opens.

Click Next. The Program Maintenance window opens.
Click Remove Products. The Product Selection window opens.

From the options listed (there are three Product Selection windows) select the Reports
option of OracleAS SPI and click Next till the Remove the Selected Products window
opens.

Click Remove.
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Integrating the Oracle AS SPI with HP Performance Manager

You must purchase and install HP Performance Manager separately. To integrate the Oracle
AS SPI with HP Performance Manager, follow these steps:

1 Install the Oracle AS SPI graph package on the Windows system running HP

Performance Manager:

Insert the HP Operations Smart Plug-ins DVD into the DVD drive of the Windows
system running Reporter. The HP Operations Manager InstallShield Wizard opens.

a

d

Click Next. The Program Maintenance window opens. Click Install Products. The
Product Selection window opens.

From the options listed (there are three Product Selection windows), select the Graph
option of Oracle AS SPI and click Next.

Complete the installation by following the instructions as you proceed.

2 To graph any Oracle Application Server metric, use the data source name—
OASSPI_METRICS

Performance Manager
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Viewing Graphs Associated with Alarm Conditions

For graphing purposes, the Oracle AS SPI organizes metrics according to type. When a
message is generated for any metric, you can view a graph of that metric value along with
related metric values.

To view a graph associated with an alarm condition (operator-initiated action must be defined
with the Oracle AS SPI policy), follow these steps:

1

In the HPOM Message Browser, double-click the message for which you want to view the
graph. The Message Properties window opens.

Click the Commands tab.
Click Start in the section Operator Initiated to start the operator-initiated command.

The operator action launches your web browser, where you can view the graph.

Viewing Graphs that Show Past or Current Conditions

To generate an available graph manually, follow these steps:

1

From the HPOM console, select Operations Manager = Graphs — SPI for Oracle Application
Server.

Double-click the graph you want to generate. A new window opens.

Select the nodes from which you want to retrieve data. Select the date range and the
granularity for the graph.

Click Finish.

) Graphs appears in the HPOM console tree only if you install HP Performance Manager on the
same system as the HPOM management server.

Viewing Graphs from the HP Performance Manager Console

If you have not installed HP performance Manager on the same system as HPOM
management server, you can view the Oracle Application Server SPI Graphs from the HP
Performance Manager console. Follow these steps:

1

Click Start - All Programs = HP = HP BTO Software > Performance Manager - Performance
Manager. The Performance Manager console opens.

From the Select Nodes pane, select the node for which you want to see graph. If the node
is not listed in the list, add the node:

a Click Admin in the menu bar. The Manage Nodes window opens.

b Click the Add a Node - icon. The Add a Node Window opens.
¢ Enter the node name and click Add.
d Click Home on the menu bar.

From the Select a Graph pane, select SPI for Oracle Application Server.
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Select the graph you want to see and click Draw.

) If you have installed HP Performance Agent to collect performance data, you must select the
SPI for Oracle Application Server- OVPA <version> from the list in the Select a Graph pane.

Removing the Oracle AS SPI Grapher Package

To remove the Oracle AS SPI Grapher package follow these steps:

1

Insert the HP Operations Smart Plug-ins DVD into the DVD drive of the Windows system
running Perfromance Manager. The HP Operations Manager InstallShield Wizard opens.

Click Next. The Program Maintenance window opens.
Click Remove Products. The Product Selection window opens.

From the options listed (there are three Product Selection windows), select the Graphs
option of OracleAS SPI and click Next till the Remove the Selected Products window
opens.

Click Remove.
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6 Troubleshooting the Oracle AS SPI

This chapter covers basic troubleshooting for Oracle AS SPI. The Error messages section of
the Oracle AS SPI online help lists error messages by number.

The Self-Healing Info Tool

The Self-Healing Info tool gathers troubleshooting information about the SPI and stores it in
a file that you can submit to HP support for assistance. For more information about this tool,
see the OASSPI Admin tools section under Tools in the Oracle AS SPI online help.

) The file created by the Self-Healing Info tool may be hidden on some Windows managed
nodes. If you do not see the file, open Windows Explorer and from the Tools menu, select
Folder Options. Click the View tab. Under Hidden files and folders, select Show hidden files and
folders.
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Log and Trace Files

Log and trace files are maintained on the managed nodes. You can gather troubleshooting
information about the Oracle AS SPI from the data logged in these log and trace files.

UNIX Managed Nodes

The following log and trace files are maintained on UNIX managed nodes (typically,
/<AgentDir>/ is /var/opt/0OV/ or /var/lpp/OV/):

File Type Log

Filename /<AgentDir>/wasspi/oas/log/config.log

Description Output from the Oracle AS SPI configuration scripts is recorded in this
log file.

File Type Log

Filename /<AgentDir>/wasspi/oas/log/errorlog

Description Oracle AS SPI logs the error messages in this file. This log file is

monitored by Oracle AS SPI policies.

File Type Log

Filename /<AgentDir>/wasspi/oas/log/wasspi oas discovery.log

Description Output from the Oracle AS SPI discovery process is recorded in this log
file.

File Type Trace

Filename /<AgentDir>/wasspi/oas/log/wasspi_ oas discovery.trc

Description Discovery binary trace file used by your HP support representative. By

default, tracing to this file is enabled. To disable tracing, in
<AgentDir>/bin/instrumentation/

wasspi_oas discovery.pl, set the $trace_on variable to 0. To
enable this trace, set the $trace_on to 1. When instrumentation is
deployed, the wasspi oas discovery.pl file is overwritten
(therefore, if you disable tracing, it becomes enabled when
instrumentation is deployed). Five archived versions are kept. A new
trace file is created when the discovery policy is run.
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File Type

Filename

Description

File Type

Filename

Description

Trace

/<AgentDir>/wasspi/oas/log/trace.log (archived files have a
three digit number appended to the filename)

Trace file used by your HP support representative. This file gives
information about the CollectorServer, regardless of whether the
Collector is set to PERSISTANT or TRANSIENT mode in the
SPIConfig file. The default value of the Collector Mode is
'PERSISTENT".

By default, tracing to this file is disabled. To enable this tracing, use
the Start Tracing application.

Trace

/<AgentDir>/wasspi/ocas/log/traceCollectorClient.log
(archived files have a three digit number appended to the filename)

Trace file used by your HP support representative. This file gives
information about the CollectorClient when the Collector is set to
'PERSISTENT' mode in the SPIConfig file. The default value of the
Collector Mode is 'PERSISTENT".

By default, tracing to this file is disabled. To enable this tracing, use
the Start Tracing application.

Windows Managed Nodes

The following log and trace files are maintained on the Windows managed nodes (for HPOM
for Windows 8.00, typically, <AgentDir> is \Program Files\HP OpenView\Data):

File Type
Filename

Description

File Type
Filename

Description

Troubleshooting the Oracle AS SP/

Log
\<AgentDir>\wasspiloas\log\config.log

Output from configuration scripts is recorded in this log file.

Log
\<AgentDir> \wasspi\oas\log\errorlog

Oracle AS SPI logs the error messages in this file. This log file is
monitored by Oracle AS SPI policies.
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File Type Trace

Filename \<AgentDir>\wasspi\oas\log\wasspi oas discovery.trc
(archived files have a three digit number appended to the filename)

Description Discovery binary trace file used by your HP support representative. By
default, tracing to this file is enabled. To disable tracing, in
\<InstallDir>\bin\instrumentation\
wasspi_ oas discovery.pl, set the $trace_on variable to 0. To
enable this trace, set the $trace_on to 1. When instrumentation is
deployed, the wasspi_oas_discovery.pl file is overwritten (therefore, if
you disable tracing, it becomes enabled when instrumentation is
deployed). Five archived versions are kept. A new trace file is created
when the discovery policy is run.

File Type Trace

Filename \<AgentDir>\wasspiloas\log\trace.log (archived files have a
three digit number appended to the filename)

Description Trace file used by your HP support representative. This file gives
information about the CollectorServer, regardless of whether the
Collector is set to PERSISTANT or TRANSIENT mode in the
SPIConfig file. The default value of the Collector Mode is
'PERSISTENT".

By default, tracing to this file is disabled. To enable this tracing, use
the Start Tracing application.

File Type Trace

Filename \<AgentDir>\wasspiloas\log\traceCollectorClient.log
(archived files have a three digit number appended to the filename)

Description Trace file used by your HP support representative. This file gives
information about the CollectorClient when the Collector is set to
'PERSISTENT' mode in the SPIConfig file. The default value of the
Collector Mode is 'PERSISTENT".

By default, tracing to this file is disabled. To enable this tracing, use
the Start Tracing application.
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Troubleshooting the Discovery Process

Problem

The OASSPI Discovery policy does not automatically discover and update the Oracle AS SPI
configuration.

Solutions
To troubleshoot the discovery process, do one or more of the following (as applicable):

e Check if there are any messages, in the message browser about managed nodes not being
discovered. If there are any messages, follow the instruction text related to that error
message.

® Check for errors in the <ovAgentDir>/wasspi/oas/log/wasspi oas discovery.trc
file on the managed node.

e Ensure that the OASSPI Discovery policies are being deployed:

From the HPOM console, select Operations Manager - Policy management > Deployment
jobs.

e Ifthe state of a OASSPI Discovery policy is Active, the policy is still being deployed.
Wait until the policy is deployed.

e Ifthe state of a OASSPI Discovery policy is Suspended or Error, check for related
error messages in the message browser and troubleshoot the problem by following the
information given in the rest of this section

e Ifthe OASSPI Discovery policies are not listed, check the message browser for the
following messages:.

WASSPI-602: Updating OAS-SPI configuration in HPOM server
WASSPI-603: Updated OracleAS spi configuration in HPOM server

These messages will appear after the OASSPI Discovery policies are deployed
successfully. If these messages do not appear, either the policies are not deployed or
the AUTO_DISCOVER check box in the configuration editor is not selected.

Follow the steps given in the rest of this section to continue troubleshooting.

e  Check if an Oracle OC4J/OHS server is installed on the managed node. If no OC4J/OHS
server is installed, install an OC4J/OHS server, and complete the configuration tasks
listed in Chapter 3, Configuring the Oracle AS SPI.

e Ensure that the Oracle Application Server is running. See Task 2: Verify the Application
Server Status on page 13.

e Verify the Java home directory. See Verifying the Java Home Directory on page 53.
e Ensure that the discovery agent is running on the managed node:

Run the command opcagt -status. The following message appears:

Service Discovery Agent OvSvcDiscAgent.cmd (1084) is running.

If this message does not appear, the agent is not running. Run the following command to
start the agent:

opcagt -start -id 13
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¢ Remove and redeploy the discovery policies:

a From the HPOM console tree, select Operations Manager - Policy management — Policy
groups — SPI for Oracle Application Server.

b  Right-click OASSPI Discovery and select All Tasks = Uninstall from... The Uninstall
policies on... window opens.

¢ Select the nodes from which you want to remove the policies and click OK.

d Follow the steps given in the section Manually Deploying the Discovery Policies on
page 53 to redeploy the discovery policies. Deploy the policies in the order mentioned
and not as a group. If you deploy the policies as a group, the policies may not be
deployed in the correct order.

¢ Ensure that the Configure OASSPI tool is not running or a configuration is not open in an
editor. Because only one process can access a configuration at a time, if a configuration is
open, other processes that must access the configuration (like the discovery policy) hang
until the file becomes available.

Other Discovery Related Problems

Problem The OASSPI Discovery policies add inaccurate information to the
configuration.
Solutions To troubleshoot, do one of the following:

¢ Verify the Java home directory. For more information, see Verifying
the Java Home Directory.

¢ Update the configuration and clear the AUTO_DISCOVER check box
in the configuration editor to prevent the OASSPI Discovery policy
from overwriting the configuration information.

Problem The following error message appears:

(PMD51) Error: Unable to deploy instrumentation files
from directory <directory name>:
(NUL16389E) Unspecified error (0x80004005). Please check
the error log on the managed node.

Solution To troubleshoot, follow these steps:

1 From the HPOM console, select Operations Manager = Policy
management = Deployment jobs.

2 Find the jobs that are in the Error state.

Right-click each job you want to restart and select All Tasks —>Restart
job.
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Problem The property of critical error messages in the HPOM console is:
Errors occurred during the distribution of the monitors.
Solve the problems and distribute the monitors again.
(OpC30-1030) .

Solution To troubleshoot, follow these steps:

1 From the HPOM console, select Operations Manager — Policy
management = Deployment jobs.

Find the jobs that are in the Error state.

Right-click each job you want to restart and select All Tasks = Restart
job.

Manually Deploying the Discovery Policies

If the OASSPI Discovery policies are not deployed successfully when you run the Discover
OracleAS tool, you can manually deploy the policies on the managed nodes on which the
Oracle OC4J/OHS Servers are running (you must deploy the policies in the given order only):

1 From the HPOM console, select Operations Manager - Policy management — Policy groups
— SPI for Oracle Application Server > OASSPI Discovery.

2 Right-click OASSPI-Messages and select All Tasks = Deploy on...The Deploy Policies on...
window opens.

3 Select the nodes on which you want to deploy the auto-discovery policies and click OK.

4  Right-click OASSPI Service Discovery and select All Tasks = Deploy on....The Deploy Policies
on... window opens.

5 Select the nodes on which you want to deploy the auto-discovery policies and click OK.

Veritying the Java Home Directory

The Oracle AS SPI Collector is dependant on the Java home directory information. Collector
will not work if the Java Home directory information is inaccurate or not available. The Java
Home directory must, therefore, be configured properly on both Windows and UNIX managed
nodes.

For the Collector to work properly, ensure one of the following:

e JAVA_HOME is correctly defined in the configuration. To edit or view the configuration,
run the Configure OASSPI tool:

a From the HPOM console, select Operations Manager = Tools = SPI for Oracle Application
Server &> OASSPI Admin.

b  Double-click Configure OASSPI. The Edit Parameters window opens.

¢ Select the nodes to configure and click Launch. The Console Status window and then
the configuration editor opens.

d Inthe configuration editor, set the JAVA_HOME property. For more information about
setting the property, see the Configuring OASSPI section in the Oracle AS SPI online
help.
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e

Run the Discover OracleAS tool on the managed nodes on which the JAVA_HOME
property was added or edited. Running the Discover OracleAS tool updates the service
map.

e The JAVA_HOME system variable is correctly defined.

On a Windows manage node, follow these steps:

a
b
c

d

e

Select Start > Settings = Control Panel.
Double-click System.

Select the Advanced tab.

Select Environment Variables....

Scroll through the System variables list. Verify the JAVA_HOME value. If
JAVA_HOME does not exist, it is not defined.

On a UNIX manage node, type:

echo $JAVA HOME.

Verify the output. If no output is returned, JAVA_HOME is not defined.

Troubleshooting the Configuration

Problem The OASSPI Discovery policy overwrites the configuration with

inaccurate information.

Solution Update the configuration and clear the AUTO_DISCOVER check box in

the configuration editor to prevent the OASSPI Discovery policy from
overwriting the configuration information.
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Troubleshooting the Tools

Problem

Solution

Problem

Solution

Problem

Solution

Problem

Solution

Troubleshooting the Oracle AS SP/

When launching the tools, the tools hang or there is no output.

The tools will not work if the memory is low. Check the performance of
the node and the management server. The physical memory available
must be more than 500 MB.

Configuration variable SERVER<n>_START CMD missing for the
server—Default Server.

Before you can successfully run the Start OracleAS tool, you must set
the START_CMD and USER properties. Set these properties using the
Configure OASSPI tool. For more information about this tool, see the
Tools group section in the OASSPI Oracle AS SPI online help.

Configuration variable SERVER<n>_STOP_CMD missing for server—
Default Server.

You must set the STOP_CMD and USER properties to run the Stop
OracleAS tool successfully. You can set these properties using the
Configure OASSPI tool. For more information about this tool, see the
Oracle AS SPI online help.

Verify tool lists files and directories related to the management server
as missing; for example:

/MGMT SERVER/SPI-Share/wasspi/oas/bin/parseDefs.pl
/MGMT SERVER/SPI-Share/wasspi/oas/bin/
processWASSPIDiscovMsg.pl

/MGMT SERVER/SPI-Share/wasspi/oas/conf

This is a known problem. The verify tool lists management server
related files if you install the Oracle Application Server on the
management server itself. This problem occurs if both the managed
node and the management server are the same.
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Problem

Solution

Problem

Solution

When launched, the Verify tool gives improper output.

Before you launch the Verify tool ensure that you have installed the
latest version of Self-Healing Service (SHS) component from the SPI
DVD.

When launched, the Self-Healing Info tool gives improper output.

Ensure that you have installed the latest version of Self-Healing
Service (SHS) component from the SPI DVD.
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Glossary

agent

A program or process running on a remote device or computer system that responds to
management requests, performs management operations, or sends performance and event
notification. An agent can provide access to managed objects and MIB variables, interpret
policy for resources and configure resources.

application

Packaged software that provides functionality designed to accomplish a set of related tasks.
An application is generally more complex than a tool.

ASCII

American Standard Code for Information Interchange.

assigned policy

A policy assigned to one or more resources in the computing environment but not yet deployed
or installed on those resources.

automatic action

A pre-configured program or script executed in response to an event, message, or a change in
information in the management database. without operator intervention.

client

When the context is network systems, a computer system on a network that accesses a service
from another computer (server). When the context is software, a program or executable
process that requests a service from a server.

client console

An instance of the user interface that appears on the client system while the application runs
on a server.

command

An instruction to a computer program that causes a specified operation to be carried out.
Commands are typically typed by users on a command line.

configuration

In a network context, the complete set of inter-related systems, devices and programs that
make up the network. For example the components of a network may include computer
systems, routers, switches, hubs, operating systems and network software. The configuration
of the network determines the way that it works and the way that it is used. In a software
context, the combination of settings of software parameters and attributes that determine the
way the software works, the way it is used, and how it appears.
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configuration file

A file that contains specifications or information that can be used for determining how a
software program should look and operate.

connection

A representation of a logical or physical relationship between objects.

console

An instance of the user interface from which the user can control an application or set of
applications.

customization

The process of designing, constructing or modifying software to meet the needs and
preferences of a particular customer or user.

data type

A particular kind of data; for example database A repository of data that is electronically
stored. Typically databases are organized so that data can be retrieved and updated.

deploy

To install and start software, hardware, capabilities, or services so that they work in the
business environment.

deployed application

An application and its components that have been installed and started to work in the
business environment.

deployed policy

A policy that is deployed on one or more resources in the computing environment.

deployment

The process of installing and activating software, hardware, capabilities or services so that
they work in the business environment.

deployment package

A software package that can be deployed automatically and installed on a managed node.

error log

An output file containing error messages.

event

An unsolicited notification such as an SNMP trap or WMI notification generated by an agent
or process in a managed object or by a user action. An event usually indicates a change in the
state of a managed object or cause an action to occur.

Hypertext Transfer Protocol (HTTP).

The protocol that World Wide Web clients and servers use to communicate.



HTTPS

Hypertext Transfer Protocol Secure.

icon
An on-screen image that represents objects that can be monitored or manipulated by the user
or actions that can be executed by the user.

managed object

A network, system, software or service object that is both monitored for performance, status
and messages and is manipulated by means of actions in the management software.

management console

An instance of the user interface from which the user can control the management application
or set of management applications. The console may be on the system that contains the
management software or it may be on another system in the management domain.

management server

A server that provides management services, processes, or a management user interface to
clients. A management server is a type of management station.

message

A structured, readable notification that is generated as a result of an event, the evaluation of
one or more events relative to specified conditions, or a change in application, system,
network, or service status.

message browser

A graphical user interface that presents notifications that are generated as a result of an
event, the evaluation of one or more events relative to specified conditions or a change in
application, system, network, or service status.

message description

Detailed information about an event or message.

message key

A message attribute that is a string used to identify messages that were triggered from
particular events.The string summarizes the important characteristics of the event. Message
keys can be used to allow messages to acknowledge other messages, and allows for the
identification of duplicate messages.

message severity level

A property of a message indicating the level of impact of the event or notification that
initiated the message. See also severity level.

metadata
Data that defines data.

metric

A measurement that defines a specific operational or performance characteristic.
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module

A self-contained software component that performs a specific type of task or provides for the
presentation of a specific type of data. Modules can interact with one another and with other
software.

node

When the context is network, a computer system or device (for example, printer, router,
bridge) in a network. When the context is a graphical point to point layout, a graphical
element in a drawing that acts as a junction or connection point for other graphical elements.

parameter

A variable or attribute that may be given an arbitrary value for use during an execution of
either a computer program or a procedure within a program.

parameter type

An abstraction or categorization of a parameter that determines the particular kind of data
that is valid for the parameter. For example a parameter type could be IP Address which
indicates that parameter values must have four numbers separated by decimals with the
value for each number being in the range of 0 to 255.

parameter value

A value given to a variable.

policy

A set of one or more specifications rules and other information that help automate network,
system, service, and process management. Policies can be deployed to various targets (for
example, managed systems, devices, network interfaces) providing consistent, automated
administration across the network.

policy management

The process of controlling policies (for example, creating, editing, tracking, deploying,
deleting) for the purposes of network, system or service management.

policy type
An abstraction or categorization of policies based on the function of the policy or the services
that the policy supports.

port

If the context is hardware, a location for passing information into and out of a network device.
If the context is ECS, a location for passing information into and out of a correlation node.

server

If the context is hardware plus software, a computer system that provides a service (for
example, management capabilities, file storage capabilities) to other computer systems
(clients) on the network. If the context is a software component, a program or executable
process that responds to and services requests issued by clients.



severity level

A property of an object indicating the status of the object. Severity level is based on the impact
of events or messages associated with the object.

Smart Plug-in (SPI)

Prepackaged software that installs into a management console and provides management
capabilities specific to a given type of business application, database, operating system, or
service.

trace log

An output file containing records of the execution of application software
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